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TEMPLATE TIPS
A reference guide for the University of 
Georgia DAR document templates. If 
you have questions about the templates 
that this document does not answer, 
contact Clarke Schwabe (ccschwabe@
uga.edu, 706-542-8386).
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COMMON TIPS
Preferred fonts and colors

Adding pages to your document

Our templates are designed specifically with UGA brand colors and fonts in mind, so please 
use only those fonts and colors designated as theme fonts and colors in the templates. 

•	 Our fonts are Georgia or Arial Narrow Bold. Generally, Georgia is good for body text and 
Arial Narrow Bold works well for titles and headers. 

•	 Your document’s primary colors should be the designated theme colors in the template. 
UGA brand colors found at brand.uga.edu/color may be used very sparingly.

Once you’ve opened a template file and you’re ready to begin constructing your document, 
you can add pages by clicking the small down-arrow next to the New Slide button in Pow-
erPoint. This will present you with all the page options. 

Some of these options have two versions, an Example sheet and a Template sheet.

The Example sheet cannot be edited outside of Slide Master view and exists to show you 
what a Template sheet can do. The Template sheet is what you should use as a page for your 
document.
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Accessing Slide Master

Saving your document

Slide Master is where you can make changes across your entire document. In Slide Master 
view, you’re able to edit every pre-set page the templates allow you to place, and those ed-
its are implemented across every page of that type in your document. For this reason, it’s 
important to be very careful about the changes you make in Slide Master.

To access Slide Master, click the View tab at the top of your PowerPoint window, then se-
lect the Slide Master button.

What you plan to do with your finished document determines how you should save the 
completed file. If you are planning on printing the document or presenting it as a digital 
document, click File, then Export. On the resulting window, make sure the selected File 
Format is PDF, then save your file. If you are planning to use the file as a PowerPoint pre-
sentation, you can simply save as normal: click File, then Save.

One change you will want to make for every document you produce using these templates 
is found in Slide Master: the header. If you want to include a header with the document 
recipient’s name(s) on it, select the top page in the list on the left side of the window, 
then click the text on the page that reads “RECIPIENT NAME HERE” and change it to your 
recipient’s name(s). If you do not wish to have a header in your document, select this text 
and delete it.

As a side note to this, two other things you should always check when creating documents with 
these templates: the cover and the table of contents. If you are using either of these pages, note 
that you must manually adjust the recipient name on the cover page and the page numbers on 
the table of contents.

When in Slide Master, do not change any settings under the Themes, Colors, Fonts or 
Background Styles buttons. Any change to these settings affects all elements of the docu-
ment and removes UGA branding.

Finally, to return to the normal view of your document, select the Slide Master tab and 
click Close Master.
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Sharing large files
In November 2020, active UGA faculty, staff and students were given access to a suite of 
Google services through their UGA MyID account. This includes Google Drive, a cloud stor-
age service that allows easy sharing of files of any size.

If the file you wish to share is too large for sending via email and you’d like to allow your 
recipient long-term access to the file, Drive is a good solution.

To access your UGA Google Drive, first go to drive.google.com. 

If you are already logged into another Google account (Fig. 1), 
click that account name at the top right of your browser window, 
then select Add another account.

If you see “Choose an account” and a list of accounts (Fig. 2), se-
lect your UGA account if you see it. Otherwise, select Use another 
account.

If you see a button at the top right that reads Go to Drive (Fig. 3), 
click it.

Next, you’ll be asked to enter your email address. Enter your 
UGA email here.

•	If you associated your UGA email with a Google account 
prior to November 2020, you will be asked if this is a 
Google Workspace account or a Personal Google Account. 
Select Google Workspace account.

You should now see the typical UGA Single Sign-On page. Log 
in as you normally would to your UGA account.

Once you’re logged in, you can create 
folders, upload files and share them 
with whoever you like. There is no lim-
it on how much data you can store on 
your Drive, so you can share files of any 
size using the Drive.

To upload files, you can either drag the 
file you wish to share directly into your 
Google Drive window, or you can click 
the New button at the top left of your 
Drive window and select File upload. 

(Fig. 1)

(Fig. 2)

(Fig. 3)
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Recording your screen
Should you need to make a presentation of your document digitally, programs like Zoom 
allow screen sharing that can make this possible in real time, but if you need to record your 
presentation for the recipient to view later, you have a few easy options.

Mac/QuickTime Player

First, make sure your document is open and you’re ready to present. If you can, it’s worth 
it to run through the presentation in full at least once before recording—you might even 
want to record this “dry run” to make sure all your equipment works as expected and to 
find any kinks in the presentation.

Also, scan your computer screen for anything you don’t want to show up in the recording. 
Recording your entire screen is the easiest way to make the recording, so look at all your 
open windows and clear out anything you don’t want to appear in your recording. You also 
probably want to close any programs that might create a notification during your presen-
tation—Outlook, Teams, Slack, whatever.

Once you’re ready, open QuickTime and select File, New Screen Recording. QuickTime will 
then ask you to select how you want to record the screen.

To share files, right click on the file you wish to share, then select Share. From here, you 
have two options. You can either share directly with individuals via an email message, or 
you can get a link that will allow to share the file with anyone who has the link.

To share directly via email, enter the email ad-
dresses of your recipients in the text field be-
neath Share with people and groups. Once you 
enter at least one address, the share window 
changes, allowing you to change the recipi-
ents’ permission level via a pulldown menu to 
the right of their name (I recommend Viewer, 
to remove the possibility of accidental changes 
to your file) and enter a message to the recipient. Once you’re ready to send, click Send at 
the bottom of the share window, and an email will be sent to the recipient with a link to the 
file.

To share via a link, click the window titled Get 
link. Once this window expands, click the pull-
down menu beneath the URL and change the 
link’s sharing setting to Anyone with the link. 
Check to make sure that the pulldown menu to 
the right of Anyone with the link has Viewer 
selected. Next, select Copy link, and the URL 
will be copied to your clipboard, ready for you 
to paste into a message to your intended recip-
ients.
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Using the buttons that appear at 
the bottom of your screen, you can 
choose to record everything that 
appears on your screen or just a 
portion of what appears on your 
screen (which brings up a box you will resize to set the bounds of what is recorded). The 
simplest way to record is to select the Record 
Entire Screen button.

You can also make some decisions about 
where you’d like to have the resulting video 
saved, whether you’d like a countdown be-
fore recording begins, what microphone—if 
any—you’d like to use, and several other 
features. I recommend enabling the 5- or 
10-second countdown so that you have a 
moment to prepare your windows (and your-
self) before recording starts.

Importantly, you can also choose where you 
want your screen recording to be saved. I 
recommend clicking Options, then Other 
Location… to select the precise location you 
want your video to save to.

When you’d like to begin recording, simply 
click into the window you want to record. If 
you’ve set a 5- or 10-second timer, you’ll see it tick down.

Once you’re done recording, click the Stop Recording button in the menu bar at the top 
of your screen. It should be to the far left of the set of icons that includes your battery and 
WiFi connection.

Windows/Xbox Game Bar

On Windows 10, you can record your screen with the push of a button… well, three buttons: 
hold the Windows and Alt buttons, then press R. But wait!

Because Windows 10 makes recording so quick and easy, make sure you have your windows 
ready before pressing those buttons. Recording will begin immediately after you press 
them.

Once you’re recording, you’ll see a small window that indi-
cates how long you’ve been recording and contains a Stop 
Recording button. Once you’re finished, click that Stop Re-
cording button.
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To find your recording, hold the Windows button and press G. This will open the Xbox 
Game Bar. If you’ve just finished your recording, you will likely see the Gallery window, but 
if you don’t, select Show all captures to see all the screen recordings you’ve made.

From here, you can delete your recording if you aren’t satisfied with it, or you can select 
Open file location to go to the folder containing your recorded file. You can move this file to 
wherever you need it to be just like you would any other file.

Zoom

Zoom’s recording functionality can pair with its screen sharing capabilities to allow you to 
package a video of yourself presenting WITH a recording of the presentation itself.

To begin, start a new meeting, get 
your presentation ready, then at the 
bottom of your Zoom window, click 
Record and Record on this Comput-
er.

The beginning of the video will always be from your camera (unless you trim the video after 
the fact, which we’ll touch on in a bit), so be prepared to open the presentation with the 
camera on you.

Once you’re ready to switch to your presentation, select Share Screen at the bottom of your 
Zoom window, then in the new window that opens, select the window containing your 
presentation and click Share, at the bottom right. You can now begin to move through 
your presentation, and a small video of yourself will remain in the top right corner.
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Once you’re finished, click Stop Share at the top of the screen to end screen sharing and 
have your camera take over the video, and once you’re fully done with the recording, click 
the right side of the Pause/Stop Recording button (this is important, as the left side of the 
button will only pause the recording, not stop it), and end the meeting.

Once you’ve ended the meeting, Zoom will take some time to convert the meeting record-
ing, and when it’s done, it will give you the opportunity to select where the recording is 
saved. Click the pulldown menu, select Choose a new location, then navigate to the folder 
where you want the recording to be saved and click Choose.

Trimming your video

Sometimes you end up with a little more on the beginning and/or end of your video than 
you’d like. Trimming those bits away is very simple on Windows or Mac.

Trimming video on Windows

Trimming video on Mac
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Body text size
When dealing with body text, we recommend using a font size no smaller than 11 pt and no 
larger than 14 pt. 

Title/header size
When sizing the text in your titles and headers, watch out for the number of lines your 
title/header creates. Use your best judgment on this—the idea is to balance emphasis with 
readability. We believe that limiting the title/header to 1 line is best, 2 lines are good, 3 are 
acceptable, but more than that begins to be distractingly large. 

Text frame resizing
Text frames can be set to either automatically resize the text within them or to resize 
themselves based on that text. This can be useful if you have a set amount of space you’d 
like to devote to text, regardless of text length, or if you need a text frame to adjust to the 
length of your text, in order to use the text frame to align other objects on your page.

TEXT

By default, all text boxes (except on the cover page) in our templates do not have either op-
tion selected. If you would like to enable these settings, though, you can do so by access-
ing Text Options.

To access a text frame’s Text Options, right-click any-
where in the text frame and select Format Text Effects. 
This will open a panel on the right side of your window. 
Here, select the Textbox button, which looks like a small 
white block of text.

This will present you with a number of options, including 
Do not Autofit, Shrink text on overflow, or Resize shape 
to fit text. These options will apply only to the text frame 
you right-clicked.

Do not Autofit: Text you enter will appear at the size you 
designate, regardless of the size of the text frame.

Shrink text on overflow: Text you enter will appear at the 
size you designate until you enter more text than will fit 
in the space of the frame. At this point, PowerPoint will 
automatically resize all text in the frame to fit.

Resize shape to fit text: Text you enter will appear at the 
size you designate. Once you enter more text that the 
frame can fit, PowerPoint will automatically resize the frame to fit.



11

Using your own photos
Sometimes the photo you need is one that didn’t come from the Development Toolkit, and 
you’re not sure how it will appear on paper—no one wants a highly pixelated image in their 
proposal. A good rule of thumb is to use photos which have a smallest dimension of 2550 
(1700 minimum).

If your image doesn’t meet the suggested 
minimums and you still want to use it, it’s 
best to print a test sheet using that image to 
see how it appears. Insert your image in the 
template, size and crop it the way you want 
it to appear, then print this page to see if the 
resulting image is too pixelated.

•	 On Mac, in a Finder window, right-click 
on your image and select Get Info. In the 
window that opens, under the More Info 
tab (click the title to open that tab if it 
isn’t already open), you will find the im-
age’s dimensions.

PHOTO/GRAPHIC

To check your image’s dimensions:
•	 On Windows, click on your photo in an 

Explorer window. The dimensions should 
appear at the bottom of the window.
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Graphic frames
In order to size your images on the page correctly and display only the part of the image 
you wish to show, you’ll need to understand how to work with graphic frames.

To resize an image on your page, click on the image, and then click and drag one of the 
8 handles (small white boxes around the image) in any direction. To maintain the aspect 
ratio of your image (in other words, to make it larger or smaller without making the image 
look “stretched”), use one of the handles on the corners of the image.

To control how much of your image is displayed, right-click your image and select Crop. 
This will add black bars around your image. By clicking and dragging those bars, you can 
control the shape of your graphic frame, which dictates how much of your image is dis-
played. For example, in the image below, only half of the image will be displayed because 
the bottom-center bar has been dragged up.

Because the handles are still visible, you can adjust the size of your image within the 
frame while cropping. You can also move your image within the frame while cropping by 
clicking and dragging the image itself.
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Working with layers

Inserting new images

PowerPoint organizes elements on each page using a layer system. This means that you can 
control which images and text appear “on top” of others. In the event that you are trying 
to put, for example, a logo over a larger image, you can use PowerPoint’s Bring to Front 
and Send to Back commands.

Right-clicking any image will present you with those options. Bring to Front and Send to 
Back move the image to either the absolute front or absolute back of the layers on your 
page, and Bring Forward and Send Backward move the image forward or backward one lay-
er at a time.

To add new images to your document, find the Picture button on the Home tab of Power-
Point. Click that button and choose Picture from File. 
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Moving elements from Slide Master to your document

Inserting PDFs

If you find an image on an example page that you’d like to move to a document of your 
own, you can easily copy and paste it. Just find the page with the image you want to copy 
within the Slide Master, right-click the image and select Copy, then return to your page, 
select Edit in the toolbar at the top of the screen, then select Paste. This should put the 
image onto your page in the exact position it was in on the example sheet, and from here 
you can adjust it as you wish.

It is possible to insert PDFs into your PowerPoint template, though you are limited to in-
serting just the first page when using PowerPoint to do this. For this reason, we encourage 
you to only insert single-page PDFs into your template document.

ON APPLE: select Picture then Picture from File on PowerPoint’s Home tab. This will allow 
you to select a PDF file just as you would any other image file.

ON PC: Click the Insert tab near the top of your PowerPoint window, then select Object, and 
in the resulting window, click “Create From File...” and navigate to your PDF.

If, however, you must insert a multiple-page PDF or a PDF of a different size than your 
PowerPoint into your document, you will need to use Adobe Acrobat.

First, create your document within the PowerPoint template, export a PDF of your docu-
ment, then open that document in Adobe Acrobat.

Next, select the Organize Pages tool on the right side of your window. Above your doc-
ument’s pages, you should now see an Insert button. Select this, and from the pulldown 
menu that appears, select From File...

Navigate to the file you wish to insert, Select it, and in the Insert Pages window that opens, 
you are able to choose exactly where in your document you’d like to insert this PDF.

Once you click OK, you’ll see the PDF’s pages where you chose to insert them. You can 
change their position by clicking and dragging. Once you’re satisified with their placement, 
click File, then Save As, and save your new, combined PDF.

If you do not have Adobe Acrobat and you need to perform this action, contact Clarke Schwabe.
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Aligning and moving objects
If you need to align one object to another, PowerPoint will automatically “snap” most ob-
jects to another object when their edges or centers are close to one another. Additionally, 
if objects have corresponding edges that are aligned—even if they are on opposite sides of 
the page—PowerPoint will display a line to illustrate their alignment. This is useful if, for 
example, you want the bottom of a text box and the bottom of a photo next to it to be per-
fectly aligned or if you want to make sure that two objects are centered with each other.

COMPOSITION

You can also align objects by selecting them and selecting the Shape Format or Picture For-
mat tab (depending on the type of object selected) from the top of your PowerPoint win-
dow. Here, you can select multiple alignment options from the Align button.
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Aligning and moving objects, continued
Sometimes, when moving objects, the “snap-to” feature might be a hindrance. If you need 
to temporarily disable the “snap-to” feature while moving objects, hold the Option key 
(on Mac) or Alt key (on Windows) to move your object freely.

Finally, the Shift key can be used while moving objects to restrict the direction of its move-
ment. When moving objects, hold Shift while dragging the object to limit its movement to 
a single horizontal, vertical or diagonal axis. This is useful if you want to move something 
directly up, down, left or right.

Ideas for document layout
One of the advantages of these templates is that while you have all the tools necessary to 
create a variety of documents, the composition of your document is up to you—you can 
build whatever you need based off of the materials you have and the info you want to con-
vey. But if you need a few ideas to get started, the next few pages show a few ways you 
might compose your document.

Six page proposal

Eight page menu of opportunity
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Double-sided one pager

Four page single fold tabloid sheet

Eight page naming opportunity menu


